
 

 

 

CardFive - Henkilökorttien suunnitteluohjelmiston 
KÄYTTÖOHJE 

 
 

1 YLEISTÄ 
 
Voit tuoda sovellukseen kuvankäsittelyohjelmalla tekemäsi korttipohjan tai 
suunnitella korttipohjan CardFivessä. 
 
Omat korttipohjat voivat olla tiedostomuodoltaan: 
 

- JPEG Image File (.jpg) 
- Bitmap Files (.bmp) 
- Tagged Image File (.tif) 
- Targa Image File (.tga) 
- GIF Image File (.gif) 
- Windows Metafile (.wmf) 

 
Vaakasuuntaisen korttipohjan resoluution tulee olla 1016 x 642 pikseliä ja 
pystysuuntaisen 642 x 1016 pikseliä.  
 
HUOM! Määrittele jo kuvankäsittelyohjelmassa omille korttipohjillesi kortin 
suunnan edellyttämä resoluutio.  
 

 

2 KORTIN SUUNNITTELUN TYÖKALUT 
 
Vakiotyökalurivi 

 
Vakiotyökalupalkin kuvakkeiden avulla voit luoda uuden kortin, avata jo olemassa 
olevan korttitiedoston, tallentaa ja tulostaa kortteja sekä muotoilla tekstiä (fontin 
tyyppi, koko, väri ja tyyli). Vakiotyökalurivin toiminnot ovat hyvin samanlaiset, 
kuin Windows-ohjelmissa yleensäkin. 
 

 

 
 

 
Piirtotyökalupalkki 
 
Voit lisätä korttiin objekteja, kuten tekstiä, kuvia ja muotoja piirtotyökalupalkin 
kuvakkeiden avulla. Piirtotyökalupalkin toiminnot löytyvät myös valikosta Draw. 



 

 

 
 
Valintatyökalu – Valitse objekti 
 
Viivatyökalu – Piirrä viiva  
 
Muodot * - Piirrä tyhjä/täytetty neliö tai tyhjä/täytetty ympyrä 
 
Teksti – Määrittele tekstialue korttiin 
 
Viivakoodi – Rajaa viivakoodin koko työkalun avulla 
 
2D Viivakoodi – Luo kaksiulotteinen viivakoodi 
 
Kuva – Määrittele korttiin lisättävän kuvan koko  
 
Kamera 
 
Biometrinen tieto – Lisää esim. sormenjälkitietoa 
 

 
*HUOM! Valitse haluamasi muoto pitämällä hiiren vasen painike pohjassa Muodot-
kuvakkeen päällä. Esiin tulevat kaikki muotovaihtoehdot. Siirrä hiiren osoitin 
haluamasi muodon päälle ja vapauta painike.  
 
Ruudukko (Grid)  
 
Kortin suunnittelutilassa näkyvä ruudukko (Grid) toimii apuvälineenä objektien 
kohdistamisessa. Saat kytketty ruudukon nopeasti päälle / pois päältä valikosta 
View => Grid. 
 
Viivaimet (Rulers) 
 
Viivaimet toimivat apuna objektien kohdistamisessa. Saat viivaimet näkyviin tai 
pois näkyvistä valikosta View => Rulers. 
 

 
Ruudukon asetukset (Grid Settings) 
 
Voit säätää ruudukon asetuksia 
valikosta Options => Grid Settings. Jos et 
halua käyttää ruudukkoa, ota rasti pois 
kohdasta Show Grid. Jos haluat sitoa 
lisäämäsi objektit ruudukkoon, laita 
rasti kohtaan Snap to Grid. Kohdasta 
Spacing voit säätää ruudukon kokoa. 

 
 
 



 

 

 

3 HENKILÖKORTIN SUUNNITTELU 
 

3.1 Uusi kortti 

Aloita valitsemalla vakiotyökaluriviltä kuvake  Uusi kortti. Uuden kortin voit 
avata myös valitsemalla: File => New.  
 
Oma korttipohja 
Jos olet suunnitellut korttipohjan kuvankäsittelyohjelmassa, tuo pohja CardFiveen 
seuraavasti:  

1. Valitse Kuva-työkalu  ja vedä kuva-alue korttiin. Esiin tulee Image 
Properties –ikkuna. 

2. Valitse painike 
Properties. Kirjoita 
kohtaan Default Path 
tiedostopolku, josta 
kuva haetaan. Valitse 
sitten OK. 

3. Valitse painike Get.  
4. Valitse haluamasi 

kuvatiedosto. Napsauta 
Open. 

5. Valitse lopuksi OK. 
 
HUOM! Jos haluat muokata kuvaa ennen kuin tuot sen sovellukseen, valitse 
kuvan alta painike Tools. Esiin tulee Image Tools –kuvanmuokkausnäkymä: 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Kortin suunta  
 
Kortin suunta on oletusarvoisesti vaakasuuntainen (Landscape). Jos haluat 
pystysuuntaisen kortin: valitse File, Card Setup, Portrait. Kortin suunta on 
muutettavissa milloin tahansa.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
Valmiit korttipohjat 
 
Lisää sovelluksessa oleva valmis kuva tai korttipohja korttiin seuraavasti: 

1. Valitse kuvake  Piirtotyökalupalkista. 
2. Vedä hiirällä kuva-alue korttiin. Esiin tulee Image Properties –ikkuna.  
3. Valitse painike Properties. Määrittele Default Path –ikkunaan tiedostopolku, 

josta kuva haetaan. Valitse sitten OK. 
4. Valitse painike Get. Näyttöön avautuu kohdassa 3 määrittelemäsi kansio. 

Valitse haluamasi kuvatiedosto ja napsauta Open. 
5. Valitse lopuksi OK. 
6. Siirry hiirellä kuvan päälle kortissa. Paina hiiren oikeaa näppäintä ja valitse 

Set as Background. Taustakuvasta tulee koko kortin kokoinen. 
 
 

Korttipohjan muokkaaminen 
 

1. Paina kuvan päällä hiiren oikeaa näppäintä ja 
valitse Edit Background. Esiin tulee Image 
Properties –ikkuna.  

2. Tee haluamasi muutokset ja valitse OK. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 
Korttipohjan vaihtaminen 
 
Korttipohjan vaihtaminen tapahtuu samoin kuin kuvan tuonti sovellukseen. Tee 
kuten kohdassa Oma korttipohja tai Valmiit korttipohjat. 

 
 
Voit suunnitella kortin molemmat puolet valitsemalla yläpalkista ko. kuvakkeen: 

 
Kortin etupuoli 
 
Kortin kääntöpuoli 
 

 
Kortin koko suunnittelutilassa 
 
Voit säätää kortin kokoa suunnittelunäkymässä View valikosta. Jos haluat 
suurentaa kortin kokoa, valitse Zoom In. Jos haluat säätää kortin kokoa 
pienemmäksi, valitse Zoom Out.  
 

3.2 Tekstin lisääminen   
 

1. Valitse Piirtotyökalupalkista tekstityökalu  .  
2. Rajaa hiiren vasen näppäin pohjassa haluamasi kokoinen tekstialue korttiin.  
3. Vapauta hiiren näppäin. Esiin tulee Text Properties-ikkuna.  
4. Kirjoita teksti Default text –ikkunaan (Text-välilehdellä). 
5. Valitse ikkunan alalaidasta fontin tyyppi, koko ja tyyli. 
6. Valitse lopuksi Apply ja OK. 
 
Tekstin asettelu 
 
Vedä tekstialue hiiren vasen näppäin pohjassa haluamaasi paikkaan.  
 
Jos haluat määritellä tekstin tarkan sijainnin millimetreinä, kaksoisnapsauta 
tekstiä ja tee määrittelyt avautuvan Properties-ikkunan Generic-välilehdellä. 
Tässä näkymässä voit myös määritellä tekstin tasauksen (Alignment). 
 
Usean tekstikentän tasaaminen 

 
1. Paina Shift-näppäin pohjaan ja valitse hiirellä kaikki kentät, jotka haluat 

tasata. 
2. Valitse valikko Edit. 
3. Valitse Align. Valitse avautuvasta valikosta tasaustapa (esim. Left).  

 
Tekstin muokkaaminen 



 

 

 
Kaksoisnapsauta tekstiä, jota haluat muokata. Saat esiin Text Properties –
ikkunan. Tee haluamasi muutokset ja valitse OK. 

 
Fontin väri 
 

Voit määritellä fontin värin yläpalkin kuvakkeesta  Text Color. Pidä hiiren vasen 
näppäin pohjassa ja siirry haluamasi värin päälle. Vapauta hiiren näppäin. Lisää 
värejä saat näkyviin valitsemalla More colors. 
TAI: 
1. Valitse Properties-ikkunan välilehti Generic.  
2. Määrittele fontin väri kohdassa Foreground Color (RGB-väri) tai valitse valmis 

väri painikkeesta Choose avautuvasta värivalikoimasta. Vielä useampia 
värivaihtoehtoja saat valitsemalla Define custom colors. 

RGB-väri 
 
Voit määritellä tekstille haluamasi RGB-värin Properties-ikkunan Generic-
välilehden kohdasta Foreground color. Määrittelyväli on 0 – 255 siten, että jos 
kaikkia on nolla, muodostuu musta väri. Jos kaikkia on suurin mahdollinen määrä 
eli 255, saadaan valkoinen väri. Vielä lisää värivaihtoehtoja saat painikkeesta 
Define Custom Colors. RGB tulee sanoista Red (punainen), Green (vihreä) ja Blue 
(sininen). 
 
Aakkosten tyypin valinta  
 
Aakkosten tyyppi on määriteltävissä Properties, Text-välilehti, painikkeesta Font. 
Valitse Script-alasvetovalikosta haluamasi aakkostyyppi (kyrilliset, arabialaiset, 
jne.). 
 

3.3 Kuvan lisääminen  

1. Valitse työkalupalkista ikoni Kuva  (Image). Osoitin muuttuu kädenkuvaksi. 
2. Rajaa hiiren vas. painike pohjassa korttiin kuva-alue. 
3. Esiin tulee Image Properties-ikkuna. 
4. Valitse painike Properties. Määrittele Default Path –ikkunaan tiedostopolku, 

josta kuva haetaan. Valitse sitten OK. 
5. Valitse painike Get. Näyttöön avautuu kohdassa 3 määrittelemäsi kansio. 

Valitse haluamasi kuvatiedosto ja napsauta Open. 
6. Valitse lopuksi OK. 
 
Kuvan sijainti 
 
Vedä kuva hiirellä haluamaasi paikkaan kortissa. Jos haluat määritellä kuvan 
tarkan sijainnin millimetreinä; valitse kuvan päällä hiiren oikea näppäin, 
Properties ja Generic-välilehti.  
 
Kuvan muokkaaminen  
 



 

 

Voit muokata kuvaa valitsemalla Tools ikkunasta Image Properties. Tools-painike 
aktivoituu, kun kuvatiedosto on valittu. Avautuvassa näkymässä voit muokata 
kuvaa vasemman reunan työkalupalkin avulla. 
 

3.4 Muiden objektien lisääminen 
 
Viiva 

1. Valitse Piirtotyökalupalkista Viiva-työkalu  . Osoitin muuttuu käden 
kuvaksi. 

2. Vedä hiiren vas. näppäin pohjassa viiva haluamaasi kohtaan kortissa.  
3. Vapauta hiiren näppäin. 
 
Viivan väri 

1. Viivan ollessa aktivoituna, voit määritellä sen värin yläpalkin kuvakkeesta 

 Line Color.  
2. Pidä hiiren vasen näppäin pohjassa ja siirry haluamasi värin päälle. 
3. Vapauta hiiren näppäin. Lisää värejä saat näkyviin valitsemalla More colors. 

 
Neliö 

1. Valitse Piirtotyökalupalkista kuvake  .  
2. Vedä hiiren vas. näppäin pohjassa neliö haluamaasi kohtaan kortissa. 
3. Vapauta hiiren näppäin. 

 
Viivakoodi 

1. Valitse Piirtotyökalupalkista kuvake  viivakoodi.  
2. Rajaa korttiin haluamasi kokoinen alue viivakoodille hiiren vas. näppäin 

pohjassa. Vapauta hiiren näppäin, kun alue on halutun kokoinen. Esiin tulee 
Bar Code Properties –ikkuna. 

3. Valitse viivakoodin tyyli. 
4. Kirjoita teksti, jonka haluat näkyvän viivakoodissa. 
5. Valitse lopuksi OK. 
 
HUOM! Eräät viivakoodityypit hyväksyvät numeroita, kirjaimia ja symboleita, 
mutta jotkut ainoastaan numeroita.  
 
Viivakoodin koon muuttaminen 
 
1. Kaksoisnapsauta viivakoodia, jonka kokoa haluat muuttaa. Esiin tulee Bar Code 

Properties –ikkuna. 
2. Määrittele ikkunan Generic-välilehdellä viivakoodille haluttu koko ja sijainti. 
 
Muiden objektien koon muuttaminen 
Kun haluat muuttaa muodon (viiva, neliö, ympyrät) kokoa: 
 
1. Valitse objekti, jonka kokoa haluat muuttaa. 



 

 

2. Valitse objektia ympäröivistä kahvoista se, jonka suuntaan haluat objektin 
kokoa muuttaa. 

3. Vedä kahvasta hiiren vas. näppäin pohjassa. 
4. Vapauta hiiren näppäin, kun objekti on halutun kokoinen. 

 
Objektien siirtäminen 
 
Kaikki objektit ovat siirreltävissä vetämällä 
hiiren vasen näppäin pohjassa objekti haluttuun 
paikkaan. Tarkka sijainti on määriteltävissä 
Properties-ikkunan Generic-välilehdellä. 
Properties-dialogi avautuu painamalla hiiren 
oikeanpuoleista näppäintä objektin päällä. 
 
 
 
 
Objektien tasaus 
 
Tasaustyökalupalkin avulla. Valitse kortista objekti/objektit, jotka haluat tasata. 
Valitse sitten tasaustyökalupalkista kuvan osoittama tasaustapa. 
tai: Kaksoisnapsauta hiirellä objektin päällä, jonka haluat tasata; saat esiin Object 
Properties –dialogin. Määrittele tasausasetukset Generic-välilehdellä. 
 
Objektin kiertäminen 
 
1. Kaksoisnapsauta objektia, jota haluat kiertää. Saat esiin objektin ominaisuudet 

(Properties) –ikkunan. 
2. Valitse Generic-välilehdeltä haluttu kiertokulma (esim. 90°). 
3. Valitse OK. 
 
Objektien järjestys 
 
Voit määritellä objektien järjestyksen  
hiiren oikeasta näppäimestä avautuvasta valikosta Tuo eteen (Send to Front) tai 
Vie taakse (Send To back). 
 
Objektin kaksinkertaistaminen 
 
1. Valitse objekti. 
2. Paina hiiren oikeaa näppäintä. 
3. Valitse Duplicate. 
4. Luotu objekti näkyy valitun objektin päällä. Vedä se hiirellä haluamaasi 

kohtaan. 
 
 



 

 

4 HENKILÖKORTTIEN SUUNNITTELU JA TIETOKANTA 
 
CardFivessa voidaan luoda uusi tietokanta tai käyttää ulkoista tietokantaa ODBC-
ajureiden (Open Database Connectivity) avulla. 
 
Tietokannan luominen CardFivessa 
 
1. Valitse Database-valikosta Connect. Esiin tulee ODBC Source Selection dialogi. 

Valitse Create Database. 
2. Esiin tulee Create Database dialogi. Kirjoita tietokannan nimi. Valitse sitten 

Create. 
3. Valitse juuri luomasi tietokannan nimi ja napsauta Next. Esiin tulee luettelo 

valittavissa olevista taulukoista. Valitse New Table. Esiin tulee Database Table 
Structure dialogi. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
4. Kirjoita taulukon nimi. Älä käytä välilyöntejä, vaan kirjoita kaikki sanat yhteen. 

Määrittele sarakkeet ja nimeä ne.  
5. Valitse sarakkeen tiedon muoto (Data type). 
6. Kun taulukko on valmis, valitse Finish. 
7. Tietokanta näkymä avautuu kortin suunnittelutilan oikealle puolelle. Voit 

navigoida, muokata, lisätä ja poistaa tietoja Tietokantatyökalupalkin avulla. 
 

 



 

 

Kortin suunnitelunäkymä   Tietokantanäkym 

Työskentely tietokantanäkymässä  
Työskentele tietokannassa oheisen työkalupalkin kuvakkeiden avulla. 
 
Tietokanta työkalupalkki 

 
 
  

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
Työkalupalkin kuvakkeiden selitykset: 

 
Selaa-näkymä (Browse View 
 
 
Yhdistä (Connect) – Yhdistä tietokantaan. 

Sulje tietokanta (Disconnect from the Database) 

Ensimmäinen (First) – Ensimmäinen tieto 

Edellinen (Previous) – Edellinen tieto 

Seuraava (Next) – Seuraava tieto 

Viimeinen (Last) – Viimeinen tieto 

Etsi (Find) – Etsi taulukosta 

Kysely (Query) – Määrittele hakukriteeri(t) 

Lisää (Add) – Lisää uusi tieto 

Poista (Delete) – Poista tieto 

Tallenna (Save) – Tallenna tieto 

Raportit (Reports) – Luo ja tulosta raportteja tietokannasta 

Ominaisuudet (Properties) – Muokkaa tietokantaliittymän ominaisuuksia 

Määrittele näkymä (Define View) – Määrittele näkymän asetukset 

 
 
 
 
 
 
 
 



 

 

5 TULOSTAMINEN 
 

5.1 Tulostimen asetukset  
 

1. Valitse File-valikosta Card Print. 
2. Valitse alasvetovalikosta käytettävä tulostin. 
3. Valitse painike Properties.  

 
Printer  
 

1. Varmista, että valittuna on välilehti Printer. 

 
 

2. Varmista, että kohdassa Application determines orientation on rasti. Näin kortti 
pysyy tulostettaessa halutun suuntaisena. Mikäli tässä kohtaa ei ole rastia, 
ohjelma saattaa oletusarvoisesti kääntää kortin toiseen suuntaan. 

 
 
 
 



 

 

 
 
Card Front  

 
 
Color Format 
Valitse Color Format –kohdasta käytettävä väriformaatti: 
 
YMC – Jos kortissa ei ole mustaa tekstiä tai viivakoodeja 
YMCK – Jos kortissa on mustaa tekstiä ja/tai viivakoodeja 
Monochrome – Jos haluat, että kortti tulostetaan mustavalkoisena 
 
Overcoat 
Jos haluat tulostaa kortteihin päällystekerroksen, laita rasti kohtaan Print 
Overcoat. Tässä voit myös määritellä haluatko tulostaa kortteihin HoloKoten 
(päällyystekerroksessa oleva, yli koko kortin pinnan ulottuva turvamerkintä) tai 
HoloPatchin (Holopatch-kortissa olevaan kultaiseen neliöön tulostettava, hyvin 
näkyvä turvamerkintä) 



 

 

 
Overcoat Options -painike 
Määrittele kohdassa Overcoat Area Selection mihin kohtaan kortissa 
päällystekerros tulostetaan. Kohdassa Overcoat Holes voit määritellä mihin kohtiin 
ei tulosteta päällystekerrosta (esim. magneettinauhan tai sirun päälle). 
Define  
 
Jos haluat määritellä tarkasti alueet, joihin Overcoatia ei tulosteta, laita rasti 
kohtaan User Defined ja valitse sitten Define-painike. Tee määritykset 
avautuvassa näkymässä ja valitse lopuksi OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Security Options - Front  
Painikkeesta Security Options avautuvassa ikkunassa voit valita millaisia 
HoloKote- /Holopatch turvamerkintöjä korttiin tulostetaan ja määritellä niiden 
sijainnin. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 
 
 

 
 
 
Card Orientation 
Jos näyttää, että jokin väri ei tulostu hyvin (riippuen värimaailmasta), voit koettaa 
kääntää korttia kohdasta Rotate. 
 
Advanced 
Advanced-välilehden toimintojen avulla voidaan määritellä värimaailmoja koskevia 
asetuksia.  
  
Colour Correction 
  
Värinkorjaus. Suositeltavaa käyttää oletusasetusta Gamma 1. Vaihtoehto Gamma 
2 soveltuu korteille, joissa vaaleita kuvia. Käytä värinkorjausta harkiten 
 



 

 

 
Color Adjustment 
Advanced-välilehden painikkeesta Colour Adjustment löydät toiminnot, joilla voit 
ohjata värimaailmoja. Voit säätää värin kirkkautta ja kontrastia (Colour Control) 
sekä värin voimakkuutta (Colour Strength). 
 
Printhead Power 
Painikkeesta Printhead Power 
säädetään lämpökirjoituspään 
tehoa. Mitä korkeampi lämpötila, 
sitä voimakkaammin 
lämpökirjoituspää siirtää väriä 
kortille. 
 
 
 
 
Printhead and Image Positions 
 
Kohdassa Image Position voidaan 
säätää milloin tulostus aloitetaan. 
Säätämällä arvoja voidaan siirtää 
kuvaa suhteessa korttiin ja korjata 
esim. kortissa oleva valkoinen 
”rantu”. 
 
 
 
 
 
 
Save / Restore 
Tällä välilehdellä voit tallentaa 
korttipohjakohtaiset ajuriasetukset (jos 
käytössä on useita korttipohjia): 
 
Save Settings to File 
Tallenna ajuritiedostosi .MDS –
muodossa. 
 
Restore Settings from File  
Lataa tallennetut .MDS –
ajuriasetustiedostot. 
 



 

 

 
 
 

5.2 Korttien tulostaminen 
 
1. Valitse File-valikosta Card Print. Avautuu alla näkyvä dialogi. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Valitse tulostin alasvetovalikosta (Destination). 
3. Valitse kohdassa Operations halutut toiminnot: 

Print – Tulosta kortti kaikkine objekteineen 
Magnetic encode – Kirjoita dataa magneettiraidalle tulostuksen 
yhteydessä 
Hologram – Tulosta kortteihin hologrammi. Edellyttää hologrammin 
tulostamiseen soveltuvaa värinauhaa. 
Contact smart card – Tulostettaessa sirukortteja. 
Contactless smart card – Tulostettaessa etäluettavia sirukortteja. 
Biometrics – Tulostettaessa biometristä, esim. sormenjälkitietoa. 
 

4. Jos tulostat kaksipuolisella tulostimella, laita rasti sekä Print Front että Print 
Back; molemmat puolet tulostuvat yhdellä kertaa.  



 

 

5. Määrittele kohdassa Print Range tulostetaanko yksi kortti (Single) vai useita 
(Multiple). 

6. Määrittele kohdassa Copies kuinka monta kpl kutakin korttia tulostetaan. 
7. Valitse lopuksi OK. 

 
Maahantuonti ja tekninen tuki 
 
Visiolink Oy 
Hermiankatu 3 A  
33720 TAMPERE 
puh. 03 2135299 
email: info@visiolink.fi 


